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April 2013 BMUG PRESENTATION
Peter Oakley introduced “Garage Band”  by 
playing some of BMUG member Brian Riggs 
compositions and demonstrated  the App 
further with some of the MacPro Video 
Tutorials to give members an idea of what 
can be achieved with the Garage Band 
Music Application.

Peter then led an informal iTunes segment which created a lot of 
interest and interaction between members and Session Leader.

Margaret Evans also held a session for Beginners in the back Hall 
which was enthusiastically supported by new members.

MAY MEETING AGENDA 
The first Segment is for all members. Bring your coffee to this 
Session and wash your cups at the break.
President’s Opening Remarks, followed by Ian Little who will 
outline how he uses Mail Merge and Pages to set up 
Membership receipts. David Dixon will give a short presentation 
on the proposed iMovie SIG. There will also be a short video 
presentation of handy computer Tips.
The Group will then divide into two, with the Beginners to move 
to the back Hall with Marg Evans. The remainder to stay in the 
main Hall to participate in a Session led by Peter Oakley. Peter 
will outline how Committee members use Apple software to 
assist them in their various Committee Positions. 
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BMUG Tip of the Month: Protect Saved Web Receipts from Accidental Overwrite

You probably already "save" receipts for online purchases by printing them to Portable Document Format (PDF) 
from the Print dialog; just open the PDF pop-up menu, choose Save PDF to Web Receipts Folder, and click Print. By 
default, the Mac saves these receipts in a Web Receipts subfolder that it creates in your Documents folder. But 
some websites reuse the same filename for all their receipts, which means that you might accidentally write over 
an old receipt with a new receipt if you're not careful. Instead of using Save PDF to Web Receipts Folder, choose 
Save as PDF and assign a custom name for each receipt. Or try this more adventurous option: Search the Net for 
an AppleScript that will automatically append date and time to the filename when you choose Save PDF to Web 
Receipts Folder. By customising filenames, this feature helps you avoid overwrites. It also simplifies finding a 
particular receipt because you can search for the date in the filename, and it's handy when you need to grab files 
by month or year, such as when filing expense reports or taxes.

When you start out learning how to use your Apple iMac, or any Apple device, we all try to seek out the 
experts.
Outside of the Apple video training tutorials, there are many publishers of books, e books, and web 
based training courses, and video tutorials, for which there is a charge.  If you are time poor, these are a 
good option.

There are many journalists, but I find the clear writing style of Christopher Breen invaluable. 
Christopher Breen has been writing about the Macintosh since the latter days of the Reagan 
administration for such publications as MacUser, MacWEEK, and Macworld. He currently writes 
Macworld's Daily Tips, as well as Game Room, the magazine's monthly games column. 
I suggest that you take some time to checkout Christopher Breen’s  Mac 101 series: http://
www.macworld.com/tag/mac101/ . There are about 26 articles up to now.

http://www.macworld.com  is an on line magazine with concise and well illustrated articles.
Other macworld journalist’s articles are equally informative, such as-
http://www.macworld.com/article/2033632/which-apple-devices-to-pack-for-your-trip.html

Happy Computing.           Peter Oakley
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Welcome to new Committee 
Member, Fay Scott 

We welcome as a new member to 
our Committee, Fay Scott, who has 
volunteered to fill the vacant 
position of Membership Secretary. 
Fay’s offer is much appreciated by 
your “Short-staffed” Committee. 

OS X Mountain Lion Update

Members are reminded that Apple 
has just released a major update to 
the Mountain Lion Operating 
System. You should download and 
install this update.

SIGs
Special Interest Groups

Among the most valuable benefits of BMUG membership are the Special Interest Groups that meet 
each month to explore various topics of interest to our members. Most SIG meetings are presented 
in an environment that many of our members find to be more interactive and content-specific than 
our monthly General Meeting. SIG meetings are especially valued by attendees in providing a 
platform for targeted learning opportunities in a wide range of Mac-based uses. Your Committee is 
endeavouring to initiate more SIG’s, but our problem is lack of volunteers willing to become 
Convenors.

iMovie SIG Group
David Dixon will conduct a 
short segment at this meeting 
with members who are 
interested in participating in 
an iMovie SIG. Matters to 

discuss will be frequency of meetings and 
venue for the SIG.

iPad SIG Group 
The iPad SIG Group commenced on 1st 
May. It will meet on the first Wednesday 
of the month between 3pm and 5pm. 

Initially, the meetings are being held in private 
residences and therefore numbers are limited. If you 
are interested in joining a waiting list for the SIG or a 
possible second SIG, please contact  Peter Oakley.

peteroakley@bellarinemac.org.au 

Genealogy SIG 
Our Genealogy SIG group is slightly 
different in that we “meet” via email.  If 
you wish to be included, please contact 
Peter Oakley.

                                  Garage Band SIG 
The Garageband SIG is available on a one to one basis run by Brian Riggs at his 
home. Contact peteroakley@bellarinemac.org.au to arrange a date/time with 
Brian.

Member Feedback
“Thank you for your great iTunes presentation last 
meeting, which answered many of my questions. I 
particularly liked the way BMUG works when 3 people 
joined in to nut out an answer to a particular query, 
each one carrying on from where the previous one had 
hit a roadblock to finally provide a solution - very 
impressive.”    Edward White
  

Lucky Door Prize at this 
Meeting

This month the lucky door prize is a one 
month macPro Video “Core Library Pass”, 

kindly provided by macPro Video.com and valued at $25 
USD. This pass will give you instant access to the 
macPro Video Online Tutorial Library for a period of one 
month from when you activate it. 

mailto:peteroakley@bellarinemac.org.au
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TREASURER WANTED

BMUG is looking for a new volunteer Treasurer .
The position includes paying all accounts, collecting 
fees and preparing monthly and Annual Financial 
Reports.
A basic knowledge of bookkeeping would be an 
advantage. 
Our current Treasurer, Ian Little, will be available to 
show you what is required. 
Ian has given notice that he will not be continuing on 
in the position after our Annual Meeting which will 
be held in September of this year.
If interested, contact Ian for more details.
ianlittle@bellarinemac.org.au

mailto:ianlittle@bellarinemac.org.au
mailto:ianlittle@bellarinemac.org.au
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Here is Neil  shooting birds with 
his binoculars and a cheap 
digital camera.

The above method was a simple and inexpensive 
technique Neil used back in his earlier days of bird 
photography.

Neil now uses more sophisticated camera equipment 
and accessories including tele photo lenses and a 
“Camo Bum Bag”

BMUG member, Neil Hickman recently featured in the 
“Ocean Grove Voice”

On the 7th March, Neil was a Guest Speaker at “The Homestead” 
Aged Care facility in Wallington. His talk was part of a ‘launch’ of a 
project to improve the gardens around “The Homestead”, so more 
birds would be attracted to the gardens.
Neil’s talk involved a DVD display of birds seen around the Bellarine.
He is a member of the Bellarine Birdlife Group and has given talks to 
our Group in the past and some of his photos have previously been 
featured in  this Newsletter.
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Books from Wiley www.wiley.com

OS X Mountain Lion For 
Dummies
This 462 page full colour book by “Dr.Mac” 
LeVitus, published in August 2012, is the 
perfect guide to help you get the most out of 
this new operating system.

Book Retail Price $29.95

This friendly, full colour guide -

• Covers OS X basics, including working with the Dock, 
Launchpad, and Mission Control; setting up your e-mail; 
surfing the web with Safari; organising your files; navigating 
with multi-touch gestures; managing your contacts and 
calendars; connecting a printer; and printing documents.

• Walks you through the new-to-OS-X features, such as 
Messages, Notes, Reminders, Notification Center, Power 
Nap, Dictation, Twitter and Facebook integration, Game 
Center, and Gatekeeper.

• Gets you up and running with iTunes and the latest apps 
from the Mac App Store and shows you how to enjoy music, 
movies, DVDs, and digital photos on your Mac.

• Provides troubleshooting tips, advice on customising and 
maintaining your Mac, and keeping your information safe 
with Time Machine.

Macs For Dummies, 12th 
Edition
This 456 page book by Edward C Baig, published 
15th March 2013, will help you get the most from 
your Mac, quickly and easily. It is the best selling 
Mac book of all time, updated for OS X Mountain 
Lion and the latest hardware.

Book Retail Price $24.95

The book helps new users or those upgrading from an earlier version of 
OS X to take full advantage of all the newest features.

It covers the most recent operating system, OS X Mountain Lion, as well 
as the latest Mac mini, MacBook Pro, MacBook Air, iMac, and Mac Pro 
hardware.

It shows how to set up your Mac, navigate the desktop, use the Dock, 
print or fax documents, surf the web with Safari, set up e-mail, use 
FaceTime and iMessage, sync devices with iCloud, run Windows on a 
Mac, and back up your files with Time Machine.

It explores the newest version of the iLife suite; how to work with 
photos, videos, and music files; blogging and social networking; 
organising your life with Reminders; setting up a network, and much 
more.

      Reviews by Peter Baldwin

May 14 2013
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Books from Woodslane Book Centre
iPad in easy steps, 4th Edition - 
covers iOS 6, for iPad 3rd and 4th 
generation and iPad2

This 240 page full colour book by 
Drew Provan, published in February 
2013, covers 3rd & 4th generation 
iPad and iPad2.

Book Retail Price $29.95

iPad in easy steps, 4th edition is the ideal guide to help the 
reader make the most of their new Apple tablet computer. 
Written in jargon-free, easy to understand language and laid out 
in easy steps with colour screenshots and illustrations, iPad in 
easy steps, 4th edition will soon have the user whizzing through 
the features of their new iPad. Covers iOS 6 for iPad 2 and iPad 
with Retina Display (3rd and 4th generation)

iMac in easy steps, 4th 
Edition - covers OS X 
Mountain Lion
This 192 page full colour book by Nick 
Vandome, published in November 2012, is 
updated for OS X Mountain Lion

Book Retail Price $29.95

Assuming no prior knowledge, "iMac in Easy Steps" is ideal for those 
users with no previous experience of the Mac platform, as well as 
helpful to users familiar with the Mac but unsure of everything the 
iMac platform has to offer. This new edition of "iMac in Easy Steps" 
guides readers from setting up their iMac to customising the desktop, 
browsing the Web using Safari, connecting with iPods and iPhones, 
editing photos, making home movies, connecting to a wireless 
network, and all the essential knowledge necessary to making the 
most of the iMac.

Reviews by Peter Baldwin
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OS X Mountain Lion: 
Peachpit Learning 
Series 

Learn how to get the most 
out of OS X Mountain Lion 
with this bestselling guide 

for beginners.

This fully updated, four-colour, course-in-a-
book by Lynn Beighley, published in 
August 2012, gets readers up-to-speed 
on Mountain Lion's new features including 
Messages, Reminders, Share Sheets, 
Gatekeeper, and more.

This book is a fantastic resource for 
beginner and intermediate Mac users. It 
begins with the basic of the basics: how to 
use the Desktop and the Finder and ends 
with high level security and troubleshooting. 
Explanations are accompanied by screenshots 
that are clearly labeled.
I like the format. It is task-oriented with lots of 
illustrations that make it easy to follow.
It is not, however, an exhaustive book on how to 
do everything you might ever want to do on your 
Mac or a book for power users. 
However, lacking in the book is a sufficient 
explanation of iCloud. iCloud is such an integral 

part of OS X Mountain Lion and can be very 
confusing to a starting user. 
Overall this is an excellent starting guide that 
is accessible to non-technical users.

Apple Training 
Series: iLife '11 

Published November 2010 
552 pages plus DVD

The Apple Training Series is both a self-paced 
learning tool and the official curriculum of the 
Apple Training and Certification Program.

In this book by Dion Scoppettuolo and Mary 
Plummer you will-
• Master the iLife suite of tools quickly through 

fun, real-world projects
• Fix, rate, and share your photos with friends 

and family 

• Turn your photos into keepsake books and 
slideshows 

• Create professional looking sports highlights 
from your home videos 

• Learn to make a “Hollywood-style” movie trailer 
• Play and record music with expert guidance 
• Fix, arrange,and mix music like a pro 
• Publish and share your projects with iWeb and 

iDVD 
This book is a great step by step guide for all 
three iLife applications. 

Even if you think you know it all, you will 
be surprised at how much you actually 
don't know. 

The book does however need updating. 
For example, "Mobile Me" is no longer 
available and the lesson on sending 
pictures tells you how to upload to 
“Mobile me” rather than the Cloud. 

Peachpit, should at the very least, have an 
Internet site where you could go to, after 
purchasing the book to get updates, similar to 
that provided for “the Missing Manuals”.

Reviews by Peter Baldwin

Books From Penguin Australia
Published by Peachpit USA
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MacJournal 6 is available at the App 
Store or directly from Mariner Software 
for $39.95. 

Whether you are tracking progress toward achieving those 
resolutions you’ve just made, chronicling the important milestones 
in your life, or simply creating a dialog with yourself, a good 
journaling application will be your constant companion throughout 
the year. It is a great tool for keeping track of daily happenings. 

MacJournal, version 6.0, recently released from Mariner Software, 
has many features. You will find that starting and keeping a journal 
for yourself, for school or business, can be as fun and entertaining 
as it is serious. 

Your MacJournal entries can be published to any of the popular 
blogging services like Blogger, WordPress, LiveJournal, Tumblr and 
more. However, if you want to keep your thoughts away from 
prying eyes, don’t worry. MacJournal is equipped with two-level 
security, password protection and AES-256 encryption. 

When you create new “Entries” for your journal you get a white 
page where you can start to type whatever is going through your 
mind. You can add images, videos, podcasts and links with a drag 
and drop and insert a link with a simple right Click on the page. 
The formatting of the text is quite basic but you can do most of the 
things that you need to do. 

MacJournal is not flashy, but it does what it does very well.

It is a viable option for all kinds of writing.

While it lacks many of the features of a writing application, MacJournal 
does a good job for “one-off” articles, correspondence and many other 
writing projects. 

      Reviewed by Peter Baldwin

EDITOR’S NOTE:
I have one only free License for this Application to give away 
as a Prize to a  worthy member.

In order to be selected for this Prize, you must submit an 
article for publication in this Newsletter outlining why you 
would like to receive the Prize and how you would use the 
Application.

I hope to receive some interesting articles for publication. 
The judges decision will be final.

https://www.marinersoftware.com/products/macjournal/
https://www.marinersoftware.com/products/macjournal/
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Products from Verbatim
Store'n'Go V3 USB 3.0 Drive 32GB 

Featuring a USB 3.0 interface for SuperSpeed data 
transfer, the Store 'n' Go V3 USB Drive is up to 10 
times faster than USB 2.0 making it faster for 
transferring and saving larger all types of file 
sizes. It is also backwards compatible to USB 2.
The design of the V3 USB Drive also ensures that 
the USB connectors are protected featuring a 'slide 
and lock' mechanism. This locks into position 
when using the drive and retracts back into a 
closed position to protect the connector when not 
in use.

The Drive featured here is the 32GB, but they come 
in many sizes from 1Gb up to 64GB. 
For more information on the  various USB and Flash Drives click on the 
link below-

http://www.verbatim.com.au/en_AU/products/usb-drives
Having trialled these Drives, supplied by Verbatim, I would highly 
recommend them. You should however note that if you only have USB 2 
Ports on your computer, then you will only achieve transfer speeds 
applicable to USB 2 Drives.

The 32Gb Drive costs approximately $30.00. The 1TB Drive costs 
approximately $110.00. More information will be supplied at the 
meeting.     Peter Baldwin

2.5" Store'n'Go Super Speed USB 3.0 1TB
This portable hard drive features high 
performance storage using a USB 3.0 “Super 
Speed” interface, which offers up to 10 times 
faster data transfer rates than USB 2.0. It is 
backwards compatible to any USB 2.0 
ports on your Mac, and it requires no 
external power for operation. 

These Hard Drives also come with Green 
Button energy saving software. Green Button 
software suspends the hard drive from 
spinning while not in use increasing 
efficiency and saving energy.

There are 3 ‘Sleep Setting’ options. Set the suspend mode to come in 
after 10 minutes of use, or by increments of 10 minutes up to 120 
minutes. 

Set the drive to suspend immediately by double clicking the Green 
Button icon on the desktop, alternatively you can set the drive to ‘Never 
Suspend the disk’. 
For more information on the  2.5” Store’n’Go super speed USB 3.0 
Drives click on the link below-
http://www.verbatim.com.au/en_AU/products/hard-drives/portable-hdd/
53023/2-5-store-n-go-super-speed-usb3-0-1tb-black

http://www.verbatim.com.au/en_AU/products/usb-drives
http://www.verbatim.com.au/en_AU/products/usb-drives
http://www.verbatim.com.au/en_AU/products/hard-drives/portable-hdd/53023/2-5-store-n-go-super-speed-usb3-0-1tb-black
http://www.verbatim.com.au/en_AU/products/hard-drives/portable-hdd/53023/2-5-store-n-go-super-speed-usb3-0-1tb-black
http://www.verbatim.com.au/en_AU/products/hard-drives/portable-hdd/53023/2-5-store-n-go-super-speed-usb3-0-1tb-black
http://www.verbatim.com.au/en_AU/products/hard-drives/portable-hdd/53023/2-5-store-n-go-super-speed-usb3-0-1tb-black


Last Month the majority of our meeting was devoted to exploring various aspects of iTunes and it was obvious 
to me that many members are eager to learn more about the App and explore the pleasures to to be derived 
from using it.
Printed below are a few iTunes Tips which I use and find very useful.
As a matter of interest, I am a Blues and Traditional Jazz tragic. I currently have 5926 items in my iTunes Folder, 

utilising 105GB of space on my iMac Hard Drive which provides a total playing time in excess of 14 hours.
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How to enter Full Screen Mode
To enter Full Screen Mode Click on the Grey 
Double Arrow at the top right of the Tool Bar,
 OR “View > Enter Full Screen”. 

How to exit Full Screen Mode
In  full screen application, slide your mouse to the 
top of the screen to show the menu bar.   Then, 
slide full right to a blue box with 2 arrow heads.  
Click the blue box to exit full screen mode.   You 
can also slide to the application's "View" menu 
and select the choice to"Exit full screen".

Use of Command+L
I use the “Command+L” short cut a lot in iTunes. 
If you are browsing around in iTunes and you 
want to get back to the song that is currently 
playing, then clicking “Command+L” will get you 
there quickly.

Navigation using Keys
If you are like me and like to browse iTunes in 
Album View, and you have several hundred 
albums, you can scroll content quite fast using 
the alpha keys on your keyboard instead of just 
the mouse to scroll in Album view.
If you are at the top of Album view and you want 
to scroll down to an artist or group whose names 
starts with “K.” - just click the “K” key and the 
user interface will jump to that part of Album 
view. 
If you type in an artist’s first name, it will jump to 
that artist’s album(s).

Choose Music-Via a Screensaver
The iTunes Artwork screensaver is built into OS X 
Mountain Lion and can be chosen using the 
Desktop & Screen saver pane within System 
Preferences (Apple Menu > System Preferences). It 
now has a feature that elevates it above a mere 
display of album cover art. By hovering your 
mouse over an individual cover image it will reveal 
a play button, which allows you to start playing 
that album (or start the track if that image 
represents a single  song). It does not matter if 
iTunes is not already playing. By clicking the Play 
Button, it will start iTunes in the background. If 
iTunes is already playing, your selected track will 
override it.
To quit the screen saver, click the Exit button at 
the bottom right of screen or tap any key.
NOTE: If you performed a clean install of OS X 
Mountain Lion, rather than an upgrade from Lion 
or Snow Leopard, the iTunes art work screensaver 
will not be installed on your system.
See an extension of this Tip following.
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Extended use of iTunes Music 
as a Screensaver
Click on the "Hot Corners..." button and set one of 
the corners on your screen to "Start Screen Saver" 
and whenever you want to play music from this 
great screensaver, just mouse (or track) over the 
corner you designate. Boom! Instant music.

Once your screensaver is engaged, your screen 
will fill up with a seemingly random selection of 
album covers from your iTunes music library and 
every few seconds, one of the albums will flip over 
to display a different cover. Then, you can mouse 
over any one of the covers, and you will instantly 
see a play button; click it, and music from that 
album will start playing.

The music will continue to play without pause 
after you disengage the screen saver and go back 
to doing whatever it is you want to do on your 
Mac. Unfortunately, at this stage, the screensaver 
can not implement your iTunes playlists

Ready for a little fun? 

Then, check out the 
Game Center!
By now many of you will be 

competent using your Mac to make you 
extremely productive. You are no doubt using 
Calendar, Contacts, Preview and TextEdit to 
save you lots of time.
 Perhaps you now have a bit of free time, 
and you're not sure what to do with it. Or 
maybe you're ready to have a little fun?
If so, you should check out Game Center, 
which is available from the Launchpad. 

Game Center is an app that manages your 
collection of Mac games, keeping track of 
them and giving you an easy way to boast 
about your prowess to others. It is also much 
more than that. You can use Game Center to 
connect with friends, see what games they 
are playing and how well they are doing. 

Note: You will need an Apple ID so that Game 
Center can keep track of your 
accomplishments in Game Center–enabled 
games and also to help you connect with 
friends. 

Why Can't You 
Read My PDF?

You can create a PDF from 
Mac OS X Mountain Lion 

applications by choosing File > Print > Save 
as PDF, saving the file to your Mac with a 
name you assign. Graphics are at full 
resolution and fonts are embedded. Then you 
can send that PDF file as an email attachment 
to someone else, who should be able to read 
the PDF regardless of the kind of computer or 
operating system he or she uses. 
So you might think that choosing File > Print 
> Mail PDF would save you a step, attaching 
the PDF directly to the email message and 
sending it to the recipient, without having to 
save the PDF to disk as a file first. In most 
cases, you would be right. This option creates 
a PDF of the file, opens Mail, creates a new 
message, and puts the PDF into the message, 
ready to send. 

However, I have noticed that people using 
AOL or PCs often can't read the files 
created this way.
    Peter Baldwin
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THE BMUG ASSIST PROGRAM
This program is still available to all members. We will attempt to 
resolve your urgent Mac problems if we can, or alternatively give 
you advice about where to seek further assistance.

Peter Oakley is available to take your call on 0409 094 655.

Margaret Evans is available to advise members new to Macs. 
Email Margaret with your query and include your Telephone 
Number. margaretevans@bellarinemac.org.au

To get the best possible answer, and a considered one, 
please email your question/ query for the “Help Desk”  
direct to peteroakley@bellarinemac.org.au 

In many cases you may find a solution to your problem by 
inserting your question in Google. It is amazing what 
information you will find.

BOOKS AVAILABLE 
TO MEMBERS AT

HUGE DISCOUNTS

For purchases of discounted books and order 
enquiries  contact-
peterbaldwin@bellarinemac.org.au

A limited supply of books will be available for 
purchase at this meeting.

May 14 2013
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Kaiser Baas iPad PhotoScanner
This scanner is brand new, has never been used apart from one 
demonstration at a BMUG meeting. It is still in its original box. 

Features
1. Scan up to A4 size photos and documents;
2. 300 dpi scan resolution;
3. Free download of the i-Scan App from the App Store;
4. Able to charge the iPad when the device is turned off;
5. Real-time preview on the iPad screen when scanning photos and 

documents.

It is an easy way to scan your photos or documents directly to your 
iPad. 
Just dock your iPad to the iPad PhotoScanner and download the free 
i-Scan app and then follow the instructions to scan your photos and 
documents up to A4 size directly to your iPad at 300 dpi resolution. 
The scanner is a very solid column shaped device with just one on/
off button. 
This scanner is suitable for any of the first three iPad versions 
(those with the 30 pin plug). They will sit in the dock at the front of 
the machine, slightly above the feeding slot. Two paper guides 

inside the slot are adjustable to accommodate various size photos or 
documents. 
The image resolution (300 dpi) and format (JPG) can not be changed. 
For more information and an instructional video about this scanner 
click on the following Link-
http://www.kaiserbaas.com/kaiser-baas-product-page/converters/
ipad-photo-scanner

The RRP of this scanner is $170.00. 
Sale Price $120.00. Contact Peter on 52434355

Seagate/Maxtor 500GB Drive

This 500GB , Firewire 400, external Drive 
with external AC power adapter, has been 
used as one of my back up Drives for 
Time Machine. It no longer has the 

storage capacity for my requirements.
It is in perfect working order and is formatted as Mac OS Extended 
(Journaled), for use on any Apple/Mac computer.

Also included as an added extra is a 
Sonnet Firewire 400-800 Adapter.

Asking Price: $40.00. 
Contact Peter on 52434355
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